
 

 

 

 

Deltek Cobra® 8.3 
Release Notes 

 

 

 

 

 

 

December 20, 2019 



 

Release Notes ii 

 

While Deltek has attempted to verify that the information in this document is accurate and complete, 
some typographical or technical errors may exist. The recipient of this document is solely responsible for 
all decisions relating to or use of the information provided herein. 

The information contained in this publication is effective as of the publication date below and is subject to 
change without notice. 

This publication contains proprietary information that is protected by copyright. All rights are reserved. No 
part of this document may be reproduced or transmitted in any form or by any means, electronic or 
mechanical, or translated into another language, without the prior written consent of Deltek, Inc. 

This edition published December 2019. 

© Deltek, Inc. 

Deltek’s software is also protected by copyright law and constitutes valuable confidential and proprietary 
information of Deltek, Inc. and its licensors. The Deltek software, and all related documentation, is 
provided for use only in accordance with the terms of the license agreement. Unauthorized reproduction 
or distribution of the program or any portion thereof could result in severe civil or criminal penalties. 

All trademarks are the property of their respective owners.  

 

  



 

Release Notes iii 

 

Contents 
Overview ....................................................................................................................................................... 1 
New Features and Enhancements ................................................................................................................ 2 

Support for IPMDR .................................................................................................................................... 2 
Ability to Select IPMDR Format ............................................................................................................. 2 
Ability to Select Control Account and Work Package Code Assignments and Linked Structures to 
Export ..................................................................................................................................................... 3 
Additional Options to Select the Level at Which to Export and Aggregate Data ................................... 4 

Additional Cost Data Export Updates ........................................................................................................ 4 
Ability to Export Access Control Information of the Selected Project .................................................... 4 
Ability to Export Estimated Actuals as a Separate Value in the DCDE File .......................................... 5 
Ability to Append Current Period Label to the Filename during Cost Data Export ................................ 6 
Ability to Export the EVMS Acceptance Date and Flag ......................................................................... 7 

New Fields Added to the Contract Information Tab of the Project Properties Dialog Box ........................ 8 
Total Row in the Project View ................................................................................................................... 9 
Integration with Primavera ....................................................................................................................... 11 

Addition of the Update Assignment % Complete Option to Primavera – Integration Wizard .............. 11 
Ability to Load Material Quantity during Integration ............................................................................. 12 
Ability to Filter Activities Loaded from a Primavera Schedule ............................................................. 14 
Updates to Primavera API Connection ................................................................................................ 14 
Oracle Primavera P6 API Documentation ........................................................................................... 16 

Support for Costpoint Cloud to Cobra Integration ................................................................................... 16 
Improved Process Logs Display .............................................................................................................. 17 

Process Logs Sorted from Newest to Oldest ....................................................................................... 17 
Filter Process Logs by User ................................................................................................................. 17 
Filter Process Logs Based on Date Range.......................................................................................... 18 

Ability to Include Progress Classes During Reclass ............................................................................... 19 
Secure Baseline Dates ............................................................................................................................ 19 
Edit Current Status Period When Prevent Editing of Historical Data is Secured .................................... 20 
Other Enhancements ............................................................................................................................... 21 

Set Default wInsight Version for New Configurations .......................................................................... 21 
Clear All Filters Applied to the Project View ........................................................................................ 23 
KONA Changed to Deltek Collaboration .............................................................................................. 23 
Enabled Save and Save As Commands Color Update ....................................................................... 24 
Display CAM and WP Manager Descriptions on Reports ................................................................... 24 



 

Release Notes iv 

 

Threshold Term Updated ..................................................................................................................... 24 
Online Help Improvements .................................................................................................................. 24 
InstallShield Wizard Updates ............................................................................................................... 27 
Support for New Technologies and Deltek Products ........................................................................... 28 

Software Issues Resolved ........................................................................................................................... 30 
Descriptions of Software Issues .............................................................................................................. 30 

API » PMC Web Services .................................................................................................................... 30 
API » Web Services ............................................................................................................................. 30 
Batch Reports » Batch Report Processing .......................................................................................... 31 
Documentation ..................................................................................................................................... 32 
Explorer View » Explorer View ............................................................................................................ 33 
Framework ........................................................................................................................................... 33 
Installation ............................................................................................................................................ 34 
Project Processes » Assignment Export or Import .............................................................................. 34 
Project Processes » Calculate Progress ............................................................................................. 35 
Project Processes » Reclass ............................................................................................................... 35 
Projects » Project Information .............................................................................................................. 37 
Projects » Project View ........................................................................................................................ 38 
Reports ................................................................................................................................................ 40 
Reports » Report Information .............................................................................................................. 40 
Reports » Report Wizard ..................................................................................................................... 41 
Reports » Reports ................................................................................................................................ 41 
Security ................................................................................................................................................ 41 
Security-Related Software Issues Resolved........................................................................................ 42 

Database Changes ..................................................................................................................................... 43 
New Columns Added ............................................................................................................................... 43 
Changes to Existing Columns ................................................................................................................. 45 

Appendix A: Viewing the Online Help ......................................................................................................... 46 
Appendix B: For Additional Information ...................................................................................................... 47 

Deltek Support Center ............................................................................................................................. 47 
Access Deltek Support Center ............................................................................................................. 47 

Available Documentation for this Release ............................................................................................... 48 
 

 



Overview 

Release Notes 1 

 

Overview 
Welcome to Deltek Cobra 8.3 Release Notes. These release notes contain a summary of the following: 

 New Features and Enhancements 

 Software Issues Resolved 

 Database Changes 
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New Features and Enhancements 
This section includes summaries of the new features and enhancements included for this release. 

Support for IPMDR 
The Office of Acquisition, Analytics and Policy (AAP) has released the updated Integrated Program 
Management Data Report (IPMDR) requirements. The IPMDR replaces the UN/CEFACT XML data 
format with a JavaScript Object Notation (JSON) format. To support these new requirements, Cobra 
extends and updates the Cost Data Export feature. 

Ability to Select IPMDR Format 
On the Project and Format page of the Cost Data wizard (previously called Project page), you can select 
which file format to generate during export. 

 
 If you select Deltek Common Data, the Cost Data wizard generates the Deltek Common Data 

Exchange (DCDE) file, a proprietary Deltek format that can be read by Acumen and wInsight. For 
example: DEMO ADVANCED.DCDE  

 If you select IPMDR - Contract Performance Format, the Cost Data wizard generates a ZIP file 
with JSON files that are compliant to the new IPMDR contractor-reporting format. 

 

Note: Deltek recommends that you run the validation tool provided by the government before you 
submit the IPMDR file. 
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Ability to Select Control Account and Work Package Code Assignments 
and Linked Structures to Export 
You can select the control account or work package code assignment to export using the Codes and 
Structures page. This page displays the information specified on the Control Account Codes tab or on the 
Work Package Codes tab of the Fields tab of the Project Properties dialog box for the selected Cobra 
project.  

 
The Codes and Structures page contains the following tabs: 

 Control Account: Click the Control Account tab to display control account code assignments 1-9 
defined on the selected project, regardless of code field type. 

 Work Package: Click the Work Package tab to display work package code assignments 1-9 
defined on the selected project, regardless of code field type. 

 

Attention: See the “Project and Format Page of the Cost Data Wizard” and “Exported Cost Data File” 
topics in the Cobra Help System. 

Attention: See the “Cost Data Export” topic in the Cobra Help System for guidelines to consider 
when creating the IPMDR format. 

Attention: See the “Codes and Structures Page of the Cost Data Wizard” topic in the Cobra Help 
System. 

https://help.deltek.com/Product/Cobra/8.3/GA/Fields%20Tab%20of%20the%20Project%20Properties%20Dialog%20Box.html
https://help.deltek.com/Product/Cobra/8.3/GA/Project%20Page%20of%20the%20Acumen%20Wizard.html
https://help.deltek.com/Product/Cobra/8.3/GA/Exported%20Cost%20Data%20File.html
https://help.deltek.com/Product/Cobra/8.3/GA/Cost%20Data%20Export%20to%20Acumen.html
https://help.deltek.com/Product/Cobra/8.3/GA/Codes%20and%20Structures%20Page%20of%20the%20Cost%20Data%20Wizard.html
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Additional Options to Select the Level at Which to Export and 
Aggregate Data 
The Data Options page (previously called Cost and Burden Details page) is updated with new options 
that you can use to select the level at which to export and aggregate data.  

 

 

Additional Cost Data Export Updates 
This section discusses the additional enhancements made to the Cost Data Export feature. 

Ability to Export Access Control Information of the Selected Project 
Cobra supports exporting of the access control information of both projects and master projects to the 
DCDE file using the Export access control to wInsight 8.1 or later option on the wInsight » Integration 
tab of the Application Preferences dialog box. 

Attention: See the “Data Options Page of the Cost Data Wizard” topic in the Cobra Help System. 

https://help.deltek.com/Product/Cobra/8.3/GA/Cost%20and%20Burden%20Details%20Page%20of%20the%20Acumen%20Wizard.html
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If you select a master project, Cobra only exports the access control information of the master project. 
Cobra does not export the access control information of its sub-projects. 

 

Ability to Export Estimated Actuals as a Separate Value in the DCDE 
File 
You can add a Cobra cost set that you can map to an Estimated Actuals cost set as a separate value 
during Cost Data Export. The Estimated Actuals value defaults to None, whether you use the Cost Data 
wizard or the API to run the export process. This means the output file will contain 0 values for Estimated 
Actuals. If the DCDE file already has a cost set mapped to Estimated Actuals, the output file will load and 
populate the correct data. 

Attention: See the “Integration Tab of the Application Preferences Dialog Box” topic in the Cobra 
Help System. 

https://help.deltek.com/Product/Cobra/8.3/GA/Integration%20Tab%20of%20the%20Application%20Preferences%20Dialog%20Box.html


New Features and Enhancements 

Release Notes 6 

 

 

 

Ability to Append Current Period Label to the Filename during Cost 
Data Export 

The Append the current period label to the filename option is added to the Save and Run Page of the 
Cost Data wizard. When you run the Cost Data wizard, selecting this option will add a label with the 
current status date to the filename. This allows you to save multiple files in one location without 
overwriting the older files. 

Attention: See the “Cost Sets Page of the Cost Data Wizard” topic in the Cobra Help System. 

https://help.deltek.com/Product/Cobra/8.3/GA/Cost%20Sets%20Page%20of%20the%20Acumen%20Wizard.html
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When you run the Cost Data Export through the API, and this option is selected, a label with the current 
status date is added to the exported filename. 

 

Ability to Export the EVMS Acceptance Date and Flag 

The EVMS Acceptance flag and Approval/Disapproval Date specified on the General tab of the Project 
Properties dialog box are included in the generated DCDE or IPMDR file. 

Attention: See the “Save and Run Page of the Cost Data Wizard” and the “Cost Data Export 
Process” topics in the Cobra Help System. 

https://help.deltek.com/Product/Cobra/8.3/GA/Save%20and%20Run%20Page%20of%20the%20Acumen%20Wizard.html
https://help.deltek.com/Product/Cobra/8.3/GA/Acumen%20Export%20Process.html
https://help.deltek.com/Product/Cobra/8.3/GA/Acumen%20Export%20Process.html
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New Fields Added to the Contract Information Tab of the 
Project Properties Dialog Box 
The Contractor Information and Contract Information panes on Contract Information tab of the Project 
Properties dialog box are updated with new fields which are exported when you generate an IPMDR file. 

Attention: See the “General Tab of the Project Properties Dialog Box” topic in the Cobra Help 
System. 

https://help.deltek.com/Product/Cobra/8.3/GA/General%20Tab%20of%20the%20Project%20Properties%20Dialog%20Box.html
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Total Row in the Project View 
To easily view the project-level values and to quickly total project data without running a report, the Total 
row is added at the top of the Spreadsheet and Time-phase panes of the Project view. The Total row 
displays project-level data based on the filter applied to the Project view. 

Attention: See the “Contract Information Tab of the Project Properties Dialog box” topic in the Cobra 
Help System. 

https://help.deltek.com/Product/Cobra/8.3/GA/Contract%20Information%20Tab%20of%20the%20Project%20Properties%20Dialog%20Box.html
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Spreadsheet Pane of the Project View 

 
Time-phase Pane of the Project View 

 
The Total row is read-only. The Total row remains on top of the panes even if you sort a column in the 
Spreadsheet pane. Columns that are not defined at the project level are displayed as blank in the Total 
row of the Spreadsheet pane. 

The Baseline Finish, Actual Finish, and Forecast Finish dates display the latest Baseline, Actual, and 
Forecast Finish dates of the control accounts displayed in the Spreadsheet pane. On the other hand, the 
Baseline Start date displays the earliest Baseline Start date of the control accounts displayed in the 
Spreadsheet pane.  

When you edit any of these dates, the updated dates will only display in the Total row after you save the 
changes. 
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The Total row displays the total time-phased spread at the project level based on the filter applied to the 
project view. 

When you use the Copy View to Excel command on the Project Edit tab, the Total row in the 
Spreadsheet pane is also copied in the generated Excel file. 

 

Integration with Primavera 
This section discusses the enhancements related to integration with Primavera. 

Addition of the Update Assignment % Complete Option to Primavera – 
Integration Wizard 
During status integration with Primavera, you can select which budget classes you want to have the 
Resource Assignment % Complete value be updated using the Update Assignment % Complete option 
on the Status page of the Integration wizard. 

Attention: See the “Spreadsheet Pane of the Project View,” “Time-phase Pane of the Project View,” 
and “Data Entry” topics of the Cobra Help System. 

https://help.deltek.com/Product/Cobra/8.3/GA/Spreadshet%20Pane%20of%20the%20Project%20View.html
https://help.deltek.com/Product/Cobra/8.3/GA/Time%20Phase%20Pane%20of%20the%20Project%20View.html
https://help.deltek.com/Product/Cobra/8.3/GA/Data%20Entry%20Time%20Phased%20Pane.html
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Ability to Load Material Quantity during Integration 
When importing from Primavera, you can indicate where to retrieve material quantities through the 
Resource Assignments page of the Integration wizard. 

Attention: See the “Status Page of the Integration Wizard — Scheduling Tools” topic in the Cobra 
Help System. 

https://help.deltek.com/Product/Cobra/8.3/GA/Status%20Page%20of%20the%20Integration%20Wizard%20Scheduling%20Tools.html
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Click the Retrieve Quantity for field to display the Lookup dialog box, where you can select one or more 
options. 

 
Selected resource types will load Quantity values for the matching Primavera resource types, while 
cleared resource types will load Cost values for the matching Primavera resource types. 
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Ability to Filter Activities Loaded from a Primavera Schedule 
You can filter data from the schedule and import only a specific portion of the schedule based on the code 
on the activities. The Filter activities loaded from the schedule option is added to the Filter Page of the 
Integration Wizard when integrating with Primavera. 

 

 

Updates to Primavera API Connection  
To integrate with Primavera and make a connection using the API, you select the Load daily time-
phased data option on the New/Edit Connection page and specify the required fields.  

Attention: See the “Resource Assignments Page of the Integration Wizard — Primavera” topic in the 
Cobra Help System. 

Attention: See the “Filter Page of the Integration Wizard – Scheduling Tools” topic in the Cobra Help 
System. 

https://help.deltek.com/Product/Cobra/8.3/GA/Resource%20Assignments%20Page%20of%20the%20Integration%20Wizard%20Primavera.html
https://help.deltek.com/Product/Cobra/8.3/GA/Filter%20Page%20of%20the%20Integration%20Wizard%20Scheduling%20Tools.html
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Previously, the connection command window displayed every time you clicked the Next button on each 
wizard page. This behavior is changed to make the connection command window display only when you 
click Next or Test on the New/Edit Connection page, or when you click the Finish button on the Process 
Complete page. 

 
When you run the integration through the API connection, and the Primavera project is blank or has no 
resources, no values will be imported but Cobra will not return any error. This behavior is changed and 
Cobra now displays an error message in the process log when this scenario is encountered. 
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Oracle Primavera P6 API Documentation 
The Cobra Integration with Oracle Primavera P6 API is documented in the Cobra 8.3 Installation Guide. 

 

Support for Costpoint Cloud to Cobra Integration 
With Cobra 8.2, Costpoint required direct access to the Cobra database in order to populate the Costpoint 
lookups on mapping screens during integration. With Costpoint Cloud, there is no direct access to the 
Cobra database so the lookups are not populated. Cobra Web Service has been enhanced to fully 
support this feature in Costpoint Cloud. 

The Costpoint to Cobra integration released with Costpoint 7.1.1 System JAR 054 (June 2019) provides 
support for the Standard Cobra Web Service (Cobra.WebService.Host.exe). Prior to this release, 
Costpoint to Cobra integration using web services was possible only through the Cobra Costpoint Web 
Service (Cobra.Costpoint.WebService.Host.exe). 

 
In addition, the Web Service Client API Help, previously in CHM format, is converted to HTML format. 
To display the Help, locate the Cobra Web Services topic in Cobra Help System and click the Web 

Attention: See “Appendix H: Cobra Integration with Oracle Primavera P6 API” in the Deltek Cobra 
8.3 Installation Guide. 

Attention: See Deltek Costpoint 7.1.1 Release Notes – Support for New Costpoint to Cobra 
Integration API and Deltek Costpoint to Cobra Integration 2.0 Technical Guide for more information. 

https://help.deltek.com/Product/Cobra/8.3/GA/Cobra%20Web%20Services.html
https://help.deltek.com/product/Cobra/8.3/GA/api/WebServiceClient/html/R_Project_Web_Service_ClientAPI.htm
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Services Client API link. You can also navigate to the Help\WebServiceClientAPI sub-folder of your 
Cobra installation folder. 

Improved Process Logs Display 
This section discusses the changes made to improve the process logs display in Cobra. 

Process Logs Sorted from Newest to Oldest 
The logs displayed in the Process Logs dialog box are sorted from the most recent process to the oldest 
process ran based on its start time, whether filters are applied or not. 

 

Filter Process Logs by User  
The Show logs for users field is added to the Process Logs dialog box. By default, this field displays the 
ID of the user currently logged into Cobra. If a user is selected, the Process Logs grid displays the 
process logs run by the specified user. An empty field displays the process logs for all users. If you are a 
SYSADMIN user or a member of the SYSADMIN group, you can view all process logs for all users. If you 
are a NON-SYSADMIN user, you can only view the logs for processes run on projects to which you have 
at least read access. 

https://help.deltek.com/product/Cobra/8.3/GA/api/WebServiceClient/html/R_Project_Web_Service_ClientAPI.htm
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Filter Process Logs Based on Date Range 
The Date Range field, added to the Process Logs dialog box, allows you to specify which process logs 
are to be displayed based on the selected period from the current calendar date.  
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Ability to Include Progress Classes During Reclass 
Cobra provides the ability to Reclass the Progress class to a different class. You can select a Progress 
class type on the Source Class page or on the Target Class page of the Reclass wizard. This is useful in 
making a copy of the earned value at a point in the status cycle, or setting progress equal to actual costs 
by copying the actual costs class into the progress class. 

 

 

Secure Baseline Dates 
There is a security option in Cobra that allows certain roles to update or prevent them from changing the 
time-phased spread values for certain budget classes. This has been updated to also prevent you from 
modifying the baseline dates of control accounts and work packages if you do not have rights to update 
budget classes included in the budget totals, as this may affect the time-phased spread values. 

If you have rights to update budget classes included in the budget totals, you can update the baseline 
dates of control accounts and work packages, even if you do not have rights to update budget classes 
that are not part of the budget totals. 

To secure update rights to a budget class, click the Project Data » Update Budget item in the EPM 
Security Administrator (EPMSA) tool. 

Attention: See the “Process Logs Dialog Box” topic in the Cobra Help System. 

Attention: See the “Reclass Guidelines,” “Source Class Page of the Reclass Wizard,” and “Target 
Class Page of the Reclass Wizard” topics in the Cobra Help System. 

https://help.deltek.com/Product/Cobra/8.3/GA/Process%20Logs%20Dialog%20Box.html
https://help.deltek.com/Product/Cobra/8.3/GA/Reclass%20Guidelines.html
https://help.deltek.com/Product/Cobra/8.3/GA/Source%20Class%20Page%20of%20the%20Reclass%20Wizard.html
https://help.deltek.com/Product/Cobra/8.3/GA/Target%20Class%20Page%20of%20the%20Reclass%20Wizard.html
https://help.deltek.com/Product/Cobra/8.3/GA/Target%20Class%20Page%20of%20the%20Reclass%20Wizard.html
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This feature impacts the following areas and processes in Cobra: 

 Project View 

 Integration using Scheduling Tools (File, Open Plan, Primavera, and MS Project) 

 Assignment Import 

 Reclass 

 

Edit Current Status Period When Prevent Editing of Historical 
Data is Secured 
Cobra allows you to edit the current status period even if the Prevent editing of historical time phased 
values option is selected using the Allow editing current period option on the Project Preferences tab 
of the Project Properties dialog box. 

Attention: See the “Secure Baseline Dates” topic in the Cobra Help System for rules and guidelines 
in modifying the baseline dates in these areas. 

https://help.deltek.com/Product/Cobra/8.3/GA/Secure%20Baseline%20Dates.html
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This option is available only if the Prevent editing of historical time phased values option is selected. If 
selected, Cobra allows you to perform the following: 

 You can edit the current period for budget and progress resource assignments in the Time-phase 
pane and Time-phase Detail pane of the Project view. 

 When you add a budget resource assignment in the Project View, the current period will be 
included when spreading the time-phased values. 

 When you edit total time-phased values of a budget resource assignment in the Project view, the 
All fiscal periods option on the Spread dialog box is enabled if the resource assignment start 
date falls on the current period. 

This option applies anywhere the Prevent editing of historical time phased values option is applicable. 

 

Other Enhancements 
This section discusses enhancements made to existing Cobra features and functionalities. 

Set Default wInsight Version for New Configurations 
You can set the default wInsight version to use for new configurations during wInsight Data Export. The 
Default version for new wInsight configurations option is added to the wInsight Integration tab of the 
Application Preferences dialog box. 

Attention: See the “Project Preferences” topic in the Cobra Help System. 

https://help.deltek.com/Product/Cobra/8.3/GA/Project%20Preferences.html
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By default, this option is blank. If not specified, the wInsight version field on the wInsight Database page 
of the wInsight wizard is set to version 6.5 by default. 
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Clear All Filters Applied to the Project View 
You can remove all filters applied to the Spreadsheet pane of the Project view using the Clear All Filters 
command on the Edit tab of the Project view. 

 

 

KONA Changed to Deltek Collaboration 
The KONA command on the Integration tab is changed to Deltek Collaboration. 

 

 

Attention: See the “Integration Tab of the Application Preferences Dialog Box” topic in the Cobra 
Help System. 

Attention: See the “Edit Tab of the Project View” and “Clear Filter” topics in the Cobra Help System. 

Attention: See the “Integration Tab” topic in the Cobra Help System. 

https://help.deltek.com/Product/Cobra/8.3/GA/Integration%20Tab%20of%20the%20Application%20Preferences%20Dialog%20Box.html
https://help.deltek.com/Product/Cobra/8.3/GA/Project%20Edit%20Tab.html
https://help.deltek.com/Product/Cobra/8.3/GA/Clear%20Filter.html
https://help.deltek.com/Product/Cobra/8.3/GA/Integration%20Tab.html
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Enabled Save and Save As Commands Color Update 
To easily recognize the difference between their enabled and disabled states, the Save and Save As 
commands are changed to blue icons when enabled.  

Command Enabled Disabled 

Save   

Save As   

 

Display CAM and WP Manager Descriptions on Reports 
When creating reports, you can display the CAM Description using the 
{CriteriaN.ManagerId.Description} tag if the CAM uses a code or a user field or the WP Manager 
Description if the WP manager uses a user field. This tag supports the Control Account and Work 
Package criteria on the Sub-Totals page of the Report wizard. 

 

Threshold Term Updated 
The term referring to the Cobra-wide settings for color changes is updated from "threshold" to "color 
band." 

 

Online Help Improvements 
The Cobra Help System has been improved in this release. 

Online Help Search  

You can search for complete phrases in topics and use an AND word search.  

The search field is in the upper corner of the Help screen. 

Attention: See the “Cobra Button” topic in the Cobra Help System. 

Attention: See the “Property Tags” topic in the Cobra Help System. 

Attention: See the “Color Band” topic in the Cobra Help System. 

https://help.deltek.com/Product/Cobra/8.3/GA/Cobra%20Button.html
https://help.deltek.com/Product/Cobra/8.3/GA/Property%20Tags.html
https://help.deltek.com/Product/Cobra/8.3/GA/Threshold%20Colors.html
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You can also click the word Deltek in the upper left corner of the Help screen to open the Help home 
page, which also has a search field. 

 

Searching for Phrases in Topics 

Enter phrases in quotation marks in the Help search field to return a list of only the topics that contain the 
complete phrase. 

Example:  

What you want to search for Entry in the help search field 

All topics that mention the cost data export “cost data export” 

Searching for Multiple Words in Topics (AND Search) 

To search for topics that include all the words that you enter in the search field, enter a plus sign (+) 
between each word. Each topic returned includes all the words that you entered in the search field, 
regardless of the order of the words or whether the words are adjacent to each other in each topic.   

Example: 

What you want to search for Entry in the help search field 

All topics that contain both the words “dcde” and “file” dcde + file 
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Searching for Multiple Words in Topics (OR Search) 

When you enter words in the help search field without quotes or plus signs, the search assumes an OR 
between each word. All the topics that have any or all of the words are returned in the search.  

An OR search is helpful when you are looking for something, but you are not sure of the name or term 
used in the help.   

Example:  

What you want to search for Entry in the help search field 

All the topics that contain the word “total” or “row” or both total row 

Scope of the Help Search 

The search field in online help searches only the help topics. It does not search for content from the 
Deltek Learning Zone or the Deltek Support Center website. 

 

A New Home Page 

The home page now has links to the Deltek Learning Zone and the Deltek Support Center websites. To 
access the home page: 

 Click the word Deltek in the upper left corner of the screen. 

 Click Home in the help navigation breadcrumb path above the Table of Contents. 

 

An Easy Way to Send Feedback to Deltek about Any Help Topic 

On any help topic, click the new Send Feedback icon in the toolbar above the topic.  

In the email that automatically opens, answer the guided questions to easily enter comments and 
suggestions for the specific topic, and click Send. The To and Subject fields in the email are prefilled 
automatically. The body of the email prefills with the help topic name.  

We appreciate your constructive feedback to help us continuously improve the online help. 

Attention: See the “Searching Online Help” in the Cobra Help System. 

https://help.deltek.com/Product/Cobra/8.3/GA/shared_Searching_Online_Help.html
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InstallShield Wizard Updates 
This section describes the changes made to the Cobra Installation wizard. 

Provides an Option to Uninstall Cobra Web Service Automatically When Detected 

The Cobra-InstallShield wizard is updated to check if the Cobra Web Service is deployed on the same 
machine where Cobra is installed. If Cobra Web Service is detected, the wizard displays the following 
message: 

 
Click Yes to allow the wizard to uninstall the Cobra Web Service first, followed by Cobra.  

 

Checks if TLS 1.0 is Enabled or Disabled 

If you are using a Microsoft SQL Server database, the Cobra-InstallShield wizard checks if TLS 1.0 is 
enabled or disabled on the machine where Cobra is installed during: 

 New installation: The wizard checks your machine after you click Next on the Database Servers 
page. 

 Upgrade installation: The wizard checks your machine after you click Next on the Welcome 
page. 

 Using the Database Upgrade wizard: The wizard checks your machine after you select a data 
source and you click Next on the Data Sources Available to Upgrade page 

If TLS 1.0 is disabled, the following message displays: 

Note: The first time you click , you must select your email application in the How Do You Want to 
Open This dialog box. Also, select the Always use this app check box so that this dialog box does 

not display each time you click . 

Attention: See the “Uninstall Cobra” and “Uninstall Cobra Web Service” sections in the Deltek Cobra 
8.3 Installation Guide for more information. 
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Support for New Technologies and Deltek Products 
Cobra 8.3 supports the following technologies and Deltek products. 

 

Supported Deployment Technology 

Operating System  Microsoft Windows Server 2019 

Citrix  Citrix Virtual Apps and Desktop 7.* (Windows Server 2019) 

SharePoint  VMWare Horizon 7 

Database Platform  Oracle 19.3 

 Oracle 18.3 

Database Driver  MS OLE DB Driver for SQL Server 

Microsoft Office  Microsoft Excel 2019 

 Microsoft Excel 365 (ProPlus) 

Scheduling Tool  Microsoft Project Standard 2019 

 Microsoft Project Professional 2019 

 Microsoft Project Server 2019 

Primavera  Primavera P6 17.12 

 Primavera P6 18.8 

Attention: See the “New Installation Steps,” “Cobra Upgrades,” “Appendix D: Cobra Database 
Upgrade Wizard,” and “Appendix F: Secure Transport Layer Security (TLS)” sections of the Deltek 
Cobra 8.3 Installation Guide for more information. 

Attention: See the “Software Requirements” section in the Deltek Cobra 8.3 Installation Guide for the 
complete list of supported and compatible technologies. 
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Supported Deployment Technology 

Deltek Integrated 
Products 

 wInsight 8.3  

 Open Plan 8.3 

 Open Plan 8.4 

 Acumen 8.4 

 Acumen 8.5 

 Acumen 8.6 

Embedded 
Technologies 

 Visual C++ 2017 Redistributable Package (x86) 

.NET Framework  Microsoft .NET Framework 4.7.1  

 Microsoft .NET Framework 4.7.2  
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Software Issues Resolved 

Descriptions of Software Issues 
You will notice that the descriptions of some software defects contain extra information, including ways to 
work around the defects. For the most part, these issues were addressed before this release through hot 
fixes, and the additional information was developed to help you decide whether or not you needed to 
install the hot fixes. 

When you install this release, you must install all fixes in the release; you cannot choose to install some 
and not others. Nevertheless, this additional information has been included in case you instituted some of 
the workarounds and can now stop using them, or you simply want more background information about 
the defect repairs.  

API » PMC Web Services 

Defect 927274  

Description: When a change request moved dates without changing the budgeted amount, the Respread 
process that was run as part of the integration did not calculate the costs correctly. 

Customers Impacted: This defect affects users who integrate Cobra with PM Compass. 

Workaround Before Fix: Run Recalc after completing a change request.  

Additional Notes: None. This is tracked in PM Compass 8.1 Cumulative Update 02 Defect 601913. 

Files Updated: 

 Cobra.Process.dll 

 Cobra.WinUI.exe 

 Cobra.WinUI.*.dll 

API » Web Services 

Defect 1192259  

Description: When there were multiple reports with the same name but with different owners and one of 
them was the last selected report in the Personal Reports pane of the Cobra Explorer, Cobra would not 
select this report when you refreshed the view if you were not the first report owner. 

Customers Impacted: This defect affects all users. 

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Model.dll 

 Cobra.Model.LoginManager.dll 
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Defect 1192262  

Description: When there were multiple reports with the same name but with different owners and 
different table types, and you created a new filter for one of these reports, Cobra would display the fields 
from the table type on the report owned by the first owner on the Field Lookup dialog box of the New 
Filter Expression dialog box. 

Customers Impacted: This defect affects all users. 

Workaround Before Fix: None. 

Additional Notes: For example, you have one report based on a project and another one based on a 
code file. When you create a new filter for the project report, Cobra will display the fields from the Code 
file table on the Field Lookup dialog box of the New Filter Expression dialog box. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Model.dll 

 Cobra.Model.LoginManager.dll 

Batch Reports » Batch Report Processing 

Defect 609214  

Description: When you ran a batch report that contained a report which no longer existed, Cobra would 
stop responding and crash. 

Customers Impacted: This defect affects all users. 

Workaround Before Fix: Remove the invalid report from the batch report definition. 

Additional Notes: None. 

Files Updated: 

 Cobra.WinUI.*.dll  

 Cobra.WinUI.exe  

 Cobra.Model.dll  

 Cobra.Model.LoginManager.dll 

Defect 1178151  

Description: When you ran a batch report with a valid specified output path that you did not have the 
write access permission to, Cobra would display the "Access denied" message for each report in the 
batch instead of a single message for the entire batch. 

Customers Impacted: This defect affects all users. 

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated: 

 Cobra.WinUI.*.dll  

 Cobra.WinUI.exe  
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 Cobra.Model.dll  

 Cobra.Model.LoginManager.dll 

Defect 1178152  

Description: When you ran a batch report that contained a report that existed multiple times with the 
same name but with different owners, Cobra would run the report owned by the first owner instead of the 
owner selected in the batch report. 

Customers Impacted: This defect affects all users. 

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated: 

 Cobra.WinUI.*.dll  

 Cobra.WinUI.exe  

 Cobra.Model.dll  

 Cobra.Model.LoginManager.dll 

Defect 1178153  

Description: When you ran a batch report without a specified output path, Cobra would not display any 
warning message. 

Customers Impacted: This defect affects all users. 

Workaround Before Fix: Specify a valid output path for the batch report. 

Additional Notes:  

 This scenario will not occur under normal circumstances because Cobra does not allow you to 
add or edit a batch report with a blank output path. 

 Cobra previously saved the reports to the user's "Temp" folder. Now, the reports are not 
generated at all. 

 When you run the Batch Report process through the API, the process hangs indefinitely. 

Files Updated: 

 Cobra.WinUI.*.dll  

 Cobra.WinUI.exe  

 Cobra.Model.dll  

 Cobra.Model.LoginManager.dll 

Documentation 

Defect 1194759  

Description: The description of the Forecast, Early, Late, and Pending Date fields on the General Tab of 
the Project View topic must be updated. 

Customers Impacted: This defect affects all users. 

Workaround Before Fix: None. 
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Additional Notes: None. 

Files Updated: 

 General Tab of the Project View.html 

Defect 1207502  

Description: The Cobra Installation Guide did not contain sufficient information on how to upgrade your 
Cobra version. 

Customers Impacted: This defect affects all users. 

Workaround Before Fix: None. 

Additional Notes: See the Upgrade from Cobra 8.x to the Latest Version section in the Cobra 8.3 
Installation Guide. 

Files Updated: 

 DeltekCobra83InstallationGuide.pdf 

Explorer View » Explorer View 

Defect 1128585  

Description: When you checked the IEAC and IEAC2 field values in the Project pane of the Cobra 
Explorer, the final values were computed based on the rounded-off values instead of the actual values. 

Customers Impacted: This defect affects all users. 

Workaround Before Fix: None. 

Additional Notes: Rounding should only be applied to the final value and not on the derived values used 
as part of the computation. 

Example: 

 IEAC is computed as ACWP + ((1/CPI)+(BAC-BCWP)). CPI is computed as BCWP/ACWP. 

 If CPI has a computed value of 1.025678, it should be used as is and not rounded off to 1.03 
when used in computing the value for IEAC. 

Files Updated: 

 Cobra.Model.dll 

 Cobra.Model.LoginManager.dll 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

Framework 

Defect 915207  

Description: When you entered a value on a blank date field on the General tab of the Project view and 
then deleted the value without clicking another date field, Cobra would encounter an unhandled exception 
error. 

Customers Impacted: This defect affects all users. 
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Workaround Before Fix: Click another date field before you delete the value you entered. 

Additional Notes: None. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 C1.C1Zip.2.dll 

 C1.C1Zip.2.XML 

 C1.Win.2.dll 

 C1.Win.C1Chart.2.dll 

 C1.Win.C1Command.2.dll 

 C1.Win.C1FlexGrid.2.dll 

 C1.Win.C1Input.2.dll 

 C1.Win.C1Ribbon.2.dll 

 C1.Win.C1Themes.2.dll 

Installation 

Defect 974838 

Description: When you installed Cobra 8.2 the length value for the WST_CDR.INTEGRATION_ID record 
in the Data Dictionary was incorrect. 

Customers Impacted: This defect affects all users who are using Cobra 8.2. 

Workaround Before Fix: None. 

Additional Notes: The length value for the WST_CDR.INTEGRATION_ID record should be 10 instead of 
4. 

Files Updated: 

 Cobra83_Upgrade_SqlServer.sql 

 Cobra83_Upgrade_Oracle.sql  

Project Processes » Assignment Export or Import 

Defect 185437  

Description: Work package and resource assignment data was missing from the exported file after 
performing assignment export.   

Customers Impacted: This defect affects all users. 

Workaround Before Fix: None. 

Additional Notes: This defect was introduced in Cobra 5.1 Hot Fix #08. 

Files Updated: 

 Cobra.WinUI.exe 
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Project Processes » Calculate Progress 

Defect 1183695  

Description: When you ran the Calculate Progress against a project with a small batch of control 
accounts and there were multiple API process running at the same time, the Cobra log would display the 
"SQL error inserting assignment records" error and the "Record locked by another user" warning. 

Customers Impacted: This defect affects all users. 

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated:  

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Process.dll 

Defect 1183708  

Description: When you ran the Calculate Progress against a work package with the Level of Effort 
progress technique, Cobra would allow the percent complete value to be calculated at less than 0 or 
greater than 100. If the percent complete value was calculated to be less than -9999.999999 or greater 
than 9999.999999, Cobra would generate the "Error updating WP PC_COMP" error. 

Customers Impacted: This defect affects all users. 

Workaround Before Fix: None. 

Additional Notes: When the percent complete value is calculated to be less than -9999.999999 or 
greater than 9999.999999, the following errors are generated on the ProcessLog.xml log file: 

 Oracle: ORA-01438: value larger than specified precision allowed for this column 

 SQL Server: Arithmetic overflow error converting float to data type numeric. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Process.dll 

Project Processes » Reclass 

Defect 1213994 

Description: When you ran the Reclass wizard, Cobra would create time-phased periods with explicit 
zero values within the specified date range if you performed the following actions on the wizard pages: 

 Set the Copy resource assignment codes field on the Options page to Source. 

 Set the Copy and Delete option on the Source Class page. 

 Selected an actual class on the Source Class page or an actual class on the Target Class page. 

 Selected the Reclass by a specific date range option on the Date Range page. 

Customers Impacted: This defect affects all users. 
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Workaround Before Fix: None. 

Additional Notes: Cobra should not create time-phased periods with explicit zero values for an Actual 
class type. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Process.dll 

Defect 1203498  

Description: When you ran the Reclass wizard, Cobra would delete the source resource assignment if 
you performed the following actions on the wizard pages: 

 Set the Copy resource assignment codes field on the Options page to Source. 

 Selected Copy and Delete on the Source Class page. 

 Selected Replace existing on the Target Class page. 

 Selected the Reclass by a specific date range option on the Date Range page and specified a 
date range that was outside the periods of the source resource assignment. 

Customers Impacted: This defect affects all users. 

Workaround Before Fix: None. 

Additional Notes: Cobra should not delete the source resource assignment because it still contains time-
phased data. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Process.dll 

Defect 1205079  

Description: When you ran the Reclass wizard, Cobra would set the date of the last period of the source 
resource assignment to the calendar date instead of the control account/work package finish date if you 
performed the following actions on the wizard pages: 

 Set the Copy resource assignment codes field on the Options page to Source. 

 Selected a non-Actual class and the Copy and Delete option on the Source Class page. 

 Selected an Actual class on the Target page. 

 Selected the Reclass by a specific date range option on the Date Range page and set a date 
range that included the last period of the source assignment. 

Customers Impacted: This defect affects all users. 

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated: 

 Cobra.WinUI.*.dll 
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 Cobra.WinUI.exe 

 Cobra.Process.dll 

Defect 1104419  

Description: The Reclass performance has been improved in the following scenarios: 

 The source and target class types were different. 

 The Add to existing option on the Target Class page was selected, and the Copy resource 
assignment codes from field on the Options page was set to Source. 

 The Add to existing option on the Target Class page was selected, and the Total Project option 
in the Criteria field on the Criteria page was selected. 

 The Add to existing option on the Target Class page was selected, and the Reclass all period 
in your project option on the Date Range page was selected. 

Customers Impacted: This defect affects all users. 

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Process.dll 

Defect 1210159  

Description: When you set invalid values in the From and To fields on the Date Range page of the 
Reclass wizard, Cobra would display the following incorrect error messages: 

 Please select a From value. 

 Please select a To value. 

Customers Impacted: This defect affects all users. 

Workaround Before Fix: None. 

Additional Notes: The correct error messages should be: 

 Please select a valid From date value. 

 Please select a valid To date value. 

Files Updated: 

 Cobra.Resources.dll 

Projects » Project Information 

Defect 421810  

Description: When you cleared the Address, State, and Zip fields on the Contract Information tab of the 
Project Properties dialog box and clicked Save, Cobra would encounter the ""Save failed - ORA-01407: 
cannot update ("WELCOM"."PROGRAM"."ADDRESS") to NULL" error. 

Customers Impacted: This defect affects users who run Cobra on an Oracle database. 
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Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated: 

 Cobra.WinUI.*.dll  

 Cobra.WinUI.exe  

 Cobra.Model.dll  

 Cobra.Model.LoginManager.dll 

Projects » Project View 

Defect 1183312  

Description: When you opened a project, the control account row in the Time-phase pane of the Project 
view displayed 0 values. 

Customers Impacted: This defect affects users who run Cobra on Oracle 12c or Oracle 18c database. 

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Model.dll 

 Cobra.Model.LoginManager.dll 

Defect 1179636  

Description: When you modified a control account or work package in the Spreadsheet pane of the 
Project view, moved to a different control account, and changed the current selection in the Result list, 
Cobra would display a dialog box asking you to save the pending changes in the currently selected 
control account even if there was none. 

Customers Impacted: This defect affects all users. 

Workaround Before Fix: None. 

Additional Notes: Changes are still saved when you click Yes on the dialog box. 

Files Updated: 

 Cobra.Resources.dll 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

Defect 1179622  

Description: When you modified multiple control accounts and applied a filter in the Spreadsheet pane of 
the Project view, Cobra only saved the changes in the currently selected control account. 

Customers Impacted: This defect affects all users. 
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Workaround Before Fix: Save all your changes by clicking save before applying a filter in the 
Spreadsheet pane. 

Additional Notes: None. 

Files Updated: 

 Cobra.Resources.dll 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

Defect 1134576  

Description: When you adjusted the work package dates in the Project view such that time-phased data 
on budget or forecast resource assignments fell outside the work package dates, and you clicked Yes 
when prompted to automatically adjust time-phased data, the corresponding control account row in the 
Time-phase pane would retain zero values for time-phased periods outside the work package dates. 

Customers Impacted: This defect affects all users. 

Workaround Before Fix: Refresh the Project view. 

Additional Notes: None. 

Files Updated: 

 Cobra.Model.dll 

 Cobra.Model.LoginManager.dll 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

Defect 1116945  

Description: The Hours VAC %, IEAC, IEAC2, and Hours IEAC2 fields in the Spreadsheet pane of the 
Project view displayed incorrect values for control account and work packages. 

Customers Impacted: This defect affects all users. 

Workaround Before Fix: None. 

Additional Notes: These fields should be computed using the following formulas: 

 IEAC = ACWP + ((1 / CPI) * (BAC - BCWP)) 

 IEAC2 = ACWP + ((1 / (CPI * SPI)) * (BAC - BCWP)) 

 Hours IEAC2 = ACWP Hours + ((1 / (CPI Hours * SPI Hours)) * (BAC Hours - BCWP Hours)) 

 Hours VAC% = ((BAC Hours - EAC Hours) / BAC Hours) * 100 

Files Updated: 

 Cobra.Model.dll 

 Cobra.Model.LoginManager.dll 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 
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Defect 1119989  

Description: The Hours SV% field in the Project pane of the Cobra Explorer was incorrectly calculated 
using this formula: ((BCWP Hours - ACWP Hours)/BCWS Hours) * 100. 

Customers Impacted: This defect affects all users. 

Workaround Before Fix: None. 

Additional Notes: The Hours SV% value should be computed using this formula: ((BCWP Hours - BCWS 
Hours)/BCWS Hours) * 100. 

Files Updated: 

 Cobra.Model.dll 

 Cobra.Model.LoginManager.dll 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

Reports 

Defect 1202233  

Description: When you opened the Access Control tab of the Report Properties dialog box of a report 
with the same name as a shared report owned by another user, Cobra would display the following 
incorrect message: 

"A shared report with this name already exist. Updating the access rights for this report has been 
disabled. However, you may still update the owner for this report." 

When you ran the Report wizard and saved a report with the same name as your personal report, Cobra 
would display the following incorrect message: "A report named '<ReportName>' and owned by 
'<ReportOwner>' already exist. Do you want to overwrite this report?" 

Customers Impacted: This defect affects all users. 

Workaround Before Fix: None. 

Additional Notes: The correct messages for these scenarios are as follows: 

 "A shared report with this name already exists. Updating the access rights for this report has 
been disabled. However, you may still update the owner for this report." 

 "A report named '<ReportName>' and owned by '<ReportOwner>' already exists. Do you want to 
overwrite this report?" 

Files Updated: 

 Cobra.Resources.dll 

Reports » Report Information 

Defect 405714  

Description: When you opened the report information tab of a report whose name was the same as the 
name of a standard report, Cobra would encounter an unhandled exception error.  

Customers Impacted: This defect affects all users.  

Workaround Before Fix: None.  
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Additional Notes: None. 

Files Updated: 

 Cobra.WinUI.*.dll  

 Cobra.WinUI.exe  

 Cobra.Model.dll  

 Cobra.Model.LoginManager.dll 

Reports » Report Wizard 

Defect 876747  

Description: When you created or edited a personal copy of a shared report with more than 2 access 
control entries, Cobra would encounter an error. 

Customers Impacted: This defect affects all users. 

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Model.dll 

 Cobra.Model.LoginManager.dll 

Reports » Reports 

Defect 1136164  

Description: Cobra did not support a report template tag with 3 sections (for example, 
{CriteriaN.CodeAsg[N].Description}) on any Format Report types except IPMR and CPR Format 3.  

Customers Impacted: This defect affects all users.  

Workaround Before Fix: None.  

Additional Notes: None. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.ReportLayoutEngine.dll 

Security 

Defect 1194363  

Description: When you logged into Cobra as a GUEST after a fresh installation, Cobra would allow you 
to access the SQL Command Utility. 
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Customers Impacted: This defect affects all users. 

Workaround Before Fix: Log into the EPM Security Administrator tool and disable the access of the 
DEFAULT role. 

Additional Notes: This issue does not impact users or groups with the DEFAULT role and who are 
upgrading their Cobra version. If you are upgrading your Cobra version, you may want to check if you 
would like to continue providing access rights to the SQL Command Utility for the GUEST user account. 

Files Updated: 

 DataTool.exe 

 DataTool.sdf 

 Cobra_Data_Oracle.sql 

 Cobra_Data_SqlServer.sql 

Security-Related Software Issues Resolved 
Additional security fixes are included in this release. 
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Database Changes  
This section includes the changes made to the database for this release. 

New Columns Added 
Table Name Column Name Data Type 

PROGRAM CONT_IDTYPE NVARCHAR(15) 

PROGRAM CONT_IDCODE NVARCHAR(20) 

PROGRAM CITY NVARCHAR(30) 

PROGRAM COUNTRY NVARCHAR(20) 

PROGRAM CONT_REPPHONE NVARCHAR(20) 

PROGRAM CONT_REPEMAIL NVARCHAR(60) 

PROGRAM CONT_TASK NVARCHAR(80) 

PROGRAM CONT_PROGRAM NVARCHAR(80) 

PROGRAM CONT_STATEMENT NTEXT 

PROGRAM CONT_PROGTYPE NVARCHAR(2) 

WST_FILE FILE_UID VARCHAR(22) 

WST_FILE FK_UID VARCHAR(22) 

WST_FILE LASTUPDATE DATETIME 

WST_FILE OWNER_ID NVARCHAR(20) 

WST_FILE TABLE_TYPE VARCHAR(30) 

WST_FILE FILE_NAME NVARCHAR(255) 

WST_FILE FILE_DATA VARBINARY(MAX) 

WST_MESSAGE_QUEUE MESSAGE_UID VARCHAR(22) 

WST_MESSAGE_QUEUE SEQUENCE INT 

WST_MESSAGE_QUEUE LASTUPDATE DATETIME 

WST_MESSAGE_QUEUE MESSAGE_STATUS VARCHAR(4) 
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Table Name Column Name Data Type 

WST_MESSAGE_QUEUE QUEUE_SERVER VARCHAR(15) 

WST_MESSAGE_QUEUE USR_ID NVARCHAR(20) 

WST_PROCESSLOG ROW_UID VARCHAR(22) 

WST_PROCESSLOG PARENT_UID VARCHAR(22) 

WST_PROCESSLOG PRD_UID INT 

WST_PROCESSLOG PERCENTCOMPLETE INT 

WST_PROCESSLOG ERRORCOUNT INT 

WST_PROCESSLOG WARNINGCOUNT INT 

WST_PROCESSLOG USER_ABORT INT 

WST_PROCESSLOG STARTDATE DATETIME 

WST_PROCESSLOG FINISHDATE DATETIME 

WST_PROCESSLOG LASTUPDATE DATETIME 

WST_PROCESSLOG PROCESS_ID VARCHAR(30) 

WST_PROCESSLOG USR_ID NVARCHAR(20) 

WST_PROCESSLOG DIR_ID NVARCHAR(22) 

WST_PROCESSLOG TABLE_TYPE VARCHAR(30) 

WST_PROCESSLOG LOGFILENAME NVARCHAR(254) 

WST_PROCESSLOG PROGRESS_TEXT NVARCHAR(254) 

WST_LICN LICN_ORG NVARCHAR(60) 

WST_LICN LICN_CLIENT_ID VARCHAR(100) 

WST_UPD SECURE INT 

WST_UPF SECURE INT 
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Changes to Existing Columns 
Table Name Column Name Data Type 

WST_AUDITLOG MACHINE_ID NVARCHAR(48) 

WST_LCK MACHINE_ID NVARCHAR(48) 

WST_LIC MACHINE_ID NVARCHAR(48) 

WST_ULI MACHINE_ID NVARCHAR(48) 

WST_TAB PRD_UID INT 

WST_TAB COTYPE NVARCHAR(30) 

WST_UPD CATEGORY VARCHAR(60) 

WST_UPD CAT_VALUE VARCHAR(2000) 

WST_UPF CATEGORY VARCHAR(60) 

WST_UPF CAT_VALUE VARCHAR(2000) 

WST_UPF DIR_UID VARCHAR(22) 
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Appendix A: Viewing the Online Help 
If you use Internet Explorer and the online help does not display correctly, you need to turn off 
Compatibility View for the browser. Click Tools » Compatibility View settings, and clear the Display 
intranet sites in Compatibility View check box. Then refresh the browser. Make sure you remove 
deltek.com (if listed) from the Websites you have added to Compatibility View list. You could also elect 
to use hosted help or the FQDN of your server in the URL (for example, server.domain) to bypass this 
issue. The Cobra 8.3 Help System URL is https://help.deltek.com/Product/Cobra/8.3/GA. 

Depending on your Internet Explorer security settings, you may be prompted to “Allow blocked content” 
when viewing the Cobra Online Help locally. This only affects Internet Explorer.  

You may also access the online help using Chrome and Firefox. 

https://help.deltek.com/Product/Cobra/8.3/GA
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Appendix B: For Additional Information 

Deltek Support Center 
The Deltek Support Center is a support Web site for Deltek customers who purchase an Ongoing Support 
Plan (OSP).  

The following are some of the many options that the Deltek Support Center provides: 
 Search for product documentation, such as release notes, install guides, technical information, 

online help topics, and white papers 

 Ask questions, exchange ideas, and share knowledge with other Deltek customers through the 
Deltek Support Center Community 

 Access Cloud-specific documents and forums 

 Download the latest versions of your Deltek products 

 Search Deltek’s knowledge base 

 Submit a support case and check on its progress 

 Transfer requested files to a Customer Care analyst 

 Subscribe to Deltek communications about your products and services 

 Receive alerts of new Deltek releases and hot fixes 

 Initiate a Chat to submit a question to a Customer Care analyst online 

 

Access Deltek Support Center 

To access the Deltek Support Center:  
1. Go to https://deltek.custhelp.com. 

2. Enter your Deltek Support Center Username and Password. 

3. Click Login. 

 

Attention: For more information regarding Deltek Support Center, refer to the online help available 
from the Web site. 

Note: If you forget your username or password, you can click the Need Help? button on the login 
screen for help. 

https://deltek.custhelp.com/


Appendix B: For Additional Information 

Release Notes 48 

 

Available Documentation for this Release 
The following table lists the Deltek documentation available for this release. Except where noted, all the 
user guides and quick reference guides listed in this table are available for download from the Deltek 
Support Center. 

Document Name Description 

Deltek Cobra 8.3 Installation Guide The Installation Guide provides step-by-step 
procedures on how to install the application. It 
also provides information about the software and 
hardware requirements of the product. 

Deltek Cobra 8.3 Online Help The Deltek Cobra Help system provides 
administrators and users with screen/field-level 
documentation for all applications and functions in 
the current release. 

You can access the Online Help from the Cobra 
application 

Deltek EPM Security Administrator Online Help The help system for the EPM Security 
Administrator provides administrators with 
screen/field-level documentation for all of the 
security features of Cobra. 

You can access the Help from the EPM Security 
Administrator application. 

Deltek Cobra 8.3 Technical Overview and System 
Requirements 

The Technical Overview and System 
Requirements document serves as a guideline for 
hardware and software requirements and provides 
your firm’s IT department with information about 
the technical deployment architecture of Cobra. 

 

 



 

 

About Deltek 
Better software means better projects. Deltek is the leading global provider of enterprise software and 
information solutions for project-based businesses. More than 23,000 organizations and millions of users 
in over 80 countries around the world rely on Deltek for superior levels of project intelligence, 
management and collaboration. Our industry-focused expertise powers project success by helping firms 
achieve performance that maximizes productivity and revenue. www.deltek.com 

http://www.deltek.com/
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